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Paper Set 1 · 30 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant

The numbers 40, 60, 32, 70 and 26 have
weights 1, 2, 3, 4, and 5 respectively. Find the
weighted mean.

A.  44.2

B.  44.8

C.  44.6

D.  44.4

✓

Q2 Quant
If 8 pencils cost ₹24, find the cost of 14 pencils.

A.  ₹39

B.  ₹42

C.  ₹45

D.  ₹48

✓

Q3 Quant
P and Q start a business. P invests ₹25,000, and Q invests ₹40,000.
After 3 months, P invests an additional ₹15,000. If the total profit at
the end of the year is ₹1,22,000, what is Q's share of the profit?

A.  ₹64,000

B.  ₹60,000

C.  ₹68,000

D.  ₹58,000

✓

Q4 Quant
A trader sells a product at a 15% loss. If the selling price is ₹850, find
the cost price.

A.  ₹1,000

B.  ₹1,200

C.  ₹1,500

D.  ₹2,000

✓

Q5 Quant
Pipes A and B can fill an empty tank in 24 minutes. Pipe A takes 40
minutes to fill the tank on its own. Find the time taken (in minutes)
by pipe B to fill the tank on its own.

A.  50

B.  54

C.  56

D.  60

✓

Q6 Quant
An investor holds 40 shares of stock A priced at ₹ 20 each and 60
shares of stock B priced at ₹ 40 each. What is the average price per
share in the investor’s portfolio?

A.  ₹ 32

B.  ₹ 34

C.  ₹ 30

D.  ₹ 40

✓

Q7 Quant

The price of a shirt is increased by 20% and then decreased by 10%.
What is the net percentage change in the price?

A.  10% increase

B.  2% decrease

C.  8% increase

D.  No change

✓

Q8 Quant
The numbers 6, 9, 12, and x are in proportion. If (x + 2), (x + 12), 18
and k are also in proportion, calculate the value of k.

A.  20

B.  24

C.  27

D.  36
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✓

Q9 Quant

If the volume of a cube is 27000 m3, then find the lateral surface
area (in m2) of the cube.

A.  3600

B.  3590

C.  3605

D.  5400

✓

Q10 Quant
The present salary of an officer is ₹14,500. It was increased by 10%
in the first year, decreased by 20% in the second year, and increased
by 34% in the third year. What was his salary at the end of the third
year?

A.  ₹17,068.40

B.  ₹17,078.40

C.  ₹17,088.40

D.  ₹17,098.40

✓

Q11 Quant
A shopkeeper fixes the marked price of an item at 50% above its
cost price. What percentage of discount on the marked price should
be allowed to gain 5%?

A.  30%

B.  33%

C.  31%

D.  29%

✓

Q12 Quant
The area of the sector of a circle having central angle of 36° is 32.4 π
cm2. What is the diameter (in cm) of the circle?

A.  18

B.  28

C.  36

D.  42

✓

Q13 Quant

Determine the type of triangle formed by the points A(1, 3), B(4, 7),
and C(6, 9).

2932

A.  Equilateral Triangle

B.  Scalene Triangle

C.  Isosceles Triangle

D.  Right Triangle

✓

Q14 Quant
Rajat travels from point A to point B at 28 km/hr and returns from
point B to point A at 44 km/hr. Find the average speed for the entire
trip (approximately up to two decimal places).

A.  34.22 km/hr

B.  34.76 km/hr

C.  34.92 km/hr

D.  34.06 km/hr

✓

Q15 Quant
Pipe A can fill a tank in 5 hours, pipe B in 30 hours, and pipe C in 60
hours. If all three pipes operate together, how many hours will they
take to fill half of the tank?

A.  2

B.  3

C.  4

D.  5
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✓

Q16 Quant
Raju invested ₹8,000 at 24% per annum, compounded annually and
₹10,000 at 24% per annum simple interest for 2 years. If he instead
invests ₹10,000 at 24% per annum, compounded annually and
₹8,000 at 24% per annum simple interest for the same period, how
much additional money would he gain by changing his investment
strategy?

A.  ₹115.20

B.  ₹112.20

C.  ₹125.20

D.  ₹113.20

✓

Q17 Quant
From a taxi stand, two cabs start at a speed of 54 km/hr at an
interval of 34 minutes, both cabs travelling in the same direction. A
man coming in the opposite direction towards the taxi stand meets
the cabs at an interval of 30 minutes. Find the speed (in km/hr) of
the man.

A.  7.2

B.  17.1

C.  6.6

D.  5.4

✓

Q18 Quant

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  2

B.  3

C.  −3

D.  −6
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✓

Q20 Quant

A.  288

B.  7776

C.  1152

D.  2304

GA

✓

Q21 GA
Two resistors, R₁ and R₂, are connected in series. If R₁ = 4 Ω and R₂ =
6 Ω, and a voltage of 20 V is applied across the combination, what is
the voltage drop across R₂?

A.  4 V

B.  6 V

C.  8 V

D.  12 V

✓

Q22 GA
Formation of ammonia (NH₃) from N₂ and H₂ is a:

A.  redox reaction

B.  displacement

C.  decomposition

D.  combination

✓

Q23 GA
Aluminum and rolling mills are mainly concentrated in which of the
following industrial areas of Odisha?

A.  Hirakud

B.  Talcher-Angul

C.  Rayagada

D.  Choudwar

✓

Q24 GA
Which Indian weightlifter won a gold medal at the Commonwealth
Weightlifting Championships 2025 in Ahmedabad, setting new
national records?

A.  Mirabai Chanu

B.  Harshada Garud

C.  Punam Yadav

D.  Bindyarani Devi

✓

Q25 GA
Which of the following hills lie on the western and northwestern
margins of the Peninsular plateau?

A.  Aravali hills

B.  Anai Mudi hills

C.  Shevroy Hills

D.  Garo hills

✓

Q26 GA
The Odisha Legislative Assembly, constituted in 1936, is which type
of legislative body?

A.  Bicameral body

B.  Unicameral body

C.  Independent body

D.  Semi-federal body

✓

Q27 GA
For which initiative did Odisha receive the Responsible Tourism
Initiative of the Year award at India International Travel Mart (IITM)
held in Chennai in July 2025?

A.  Promoting sustainable tourism

B.  Developing a coastal circuit

C.  Tribal tourism Scheme

D.  Launching a digital Explore Odisha

✓

Q28 GA
Who won the Best FIFA Men’s Coach Award for 2025?

A.  Luis Enrique

B.  Pep Guardiola

C.  Carlo Ancelotti

D.  Sarina Wiegman
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✓

Q29 GA
In September 2025, DRDO successfully tested the Agni-Prime missile
in collaboration with which command?

A.  Defence Cyber Agency

B.  Strategic Forces Command

C.  Andaman and Nicobar Command

D.  Indian Navy Missile Wing

✓

Q30 GA
The Odisha Government’s ‘Ama Sathi’ Unified WhatsApp BOT
received which recognition in February 2026?

A.  Technology Sabha Excellence Award

B.  National e-Governance Gold Award

C.  Digital India Innovation Award

D.  Smart Governance Platinum Award

✓

Q31 GA
During the early years of independence (1950s–1970s), India
experienced a slow rate of GDP growth, often between 3% and 4%.
What term was commonly used to describe this specific growth
rate?

A.  The Nehruvian stagnation

B.  The Hindu rate of growth

C.  The Socialist growth model

D.  The Pre-liberalization cycle

✓

Q32 GA
In February 2026, INS Anjadip was inducted by the Indian Navy at
which of the following ports?

A.  Kochi Port

B.  Mumbai Port

C.  Chennai Port

D.  Visakhapatnam Port

✓

Q33 GA
Which of the following cities lies nearest to the Prime Meridian (0°
longitude)?

A.  New York

B.  Tokyo

C.  London

D.  Sydney

✓

Q34 GA
Which of the following languages is primarily associated with the
composition of Sangam literature in ancient India?

A.  Hindi

B.  Sanskrit

C.  Pali

D.  Tamil

✓

Q35 GA
Which of the following pairs is NOT correctly matched with respect
to the characteristic ecosystem or flagship species of the
conservation site?

A.  Kaziranga National Park - One-horned rhinoceros

B.  Sundarbans National Park - Tropical evergreen rainforest

C.  Gir National Park - Asiatic lion

D.  Jim Corbett National Park - Tiger reserve

✓

Q36 GA
Which Act transferred powers of governance from the East India
Company to the British Crown?

A.  Regulating Act, 1773

B.  Government of India Act, 1919

C.  Government of India Act, 1858

D.  Government of India Act, 1935

✓

Q37 GA
If a food chain is disrupted at the producer level, what is the
immediate consequence?

A.  Carnivores multiply rapidly

B.  Decomposers dominate

C.  Herbivores become producers

D.  Consumers lose an energy source

✓

Q38 GA
Which Congress session in 1898 saw significant demonstrations
against British India's newly formed Press Committees?

A.  11th Session Poona

B.  14th Session Madras

C.  15th Session Lucknow

D.  17th Session Calcutta
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✓

Q39 GA
In which century is Kathakali dance form believed to have evolved?

A.  15th century

B.  16th century

C.  19th century

D.  18th century

✓

Q40 GA
The Indo-Gangetic Plains are primarily formed by which of the
following processes?

A.  Alluvial deposition

B.  Volcanic eruption

C.  Glacial movement

D.  Tectonic uplift

English

✓

Q41 English
Select the most appropriate article to fill in the blank. If no article is needed, select ‘No article required’.

She requested me to buy ______ box of matches from the market.

A.  the

B.  a

C.  an

D.  No article required

✓

Q42 English
Select the most appropriate option that rectifies the INCORRECTLY spelt words in the given sentence.

She explained the thieory of quantum Physiqs in a simple manner.

A.  thewery, Physiques

B.  theiroy, Physics

C.  theory, Physics

D.  thiory, Phycis

✓

Q43 English
Select the most appropriate idiom that can substitute the underlined segment in the given sentence.

The company was planning something in secret to surprise their employees on the annual day.

A.  to let the cat out of the bag

B.  to do a thing under the rose

C.  to spill the beans

D.  to call it a day
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✓

Q44 English
Choose the correct form of present tense of the verb given in the bracket to complete the given sentence.

The data __________ (reveal) that the family prioritises essential expenses over miscellaneous items.

A.  reveals

B.  was revealed

C.  is revealing

D.  has been revealing

✓

Q45 English

Read the passage and choose the correct answer to the questions based on it.

Jaisalmer, often called the "Golden City," is a stunning desert town located in the heart of the Thar Desert, Rajasthan. Its distinctive nickname
comes from the yellow sandstone used in its architecture, which glows like gold at sunset. The centerpiece is the magnificent Jaisalmer Fort, a
UNESCO World Heritage site and one of the world's few living forts, where nearly a quarter of the old city's population still resides. Constructed in
the 12th century, the fort houses intricately carved Jain temples and havelis (mansions) adorned with elaborate facades. Beyond the fort, the city
is famed for the Sam Sand Dunes, offering visitors an authentic experience of the desert landscape through camel safaris and traditional folk
performances. Jaisalmer's isolation has helped preserve its unique medieval charm and rich cultural heritage, making it a compelling study in
desert resilience, trade history, and architectural brilliance.

Which of the following would be the most precise title for the passage?

A.  The History of Fort Construction in Rajasthan

B.  Jaisalmer: Heritage in the Thar Desert

C.  The Wonders of the Sam Sand Dunes

D.  Jain Temples and Havelis in Medieval India

✓

Q46 English
What is the predominant tone of the passage when describing Jaisalmer?

A.  Critical and analytical of its isolation

B.  Informative and appreciative of its culture

C.  Speculative and uncertain about its future

D.  Detached and purely logistical

✓

Q47 English
Which of the following facts is explicitly stated in the passage about Jaisalmer Fort?

A.  It was built in the 16th century but broke down.

B.  It is the largest fort in India and even the world.

C.  It is home to a portion of the old city's population.

D.  It is constructed primarily from marble and stone.
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✓

Q48 English
What can be inferred about Jaisalmer's enduring unique character?

A.  It is primarily due to recent heavy investment in modernization.

B.  Its geographical isolation has safeguarded its historical charm.

C.  Its historical trade significance has completely faded away.

D.  The fort's current function is solely as a museum and not a residence.

✓

Q49 English
Choose the word from the passage that is an antonym for "commonplace".

A.  Magnificent

B.  Intricately

C.  Unique

D.  Compelling

✓

Q50 English
Choose the option that correctly replaces the underlined proverb in the sentence below.
The professor concluded by saying, fools rush in where angels fear to tread.

A.  reckless people act without considering danger

B.  wisdom always avoids bold action

C.  courage is more valuable than caution

D.  bravery is the key to discovery

✓

Q51 English
In the given question, a statement divided into different segments is given. The first segment is fixed, rearrange the other segments to form a
coherent statement.

The mountain appeared distant, / rising sharply against the horizon (P) / wrapped in mist and mystery (Q) / challenging every traveller who
approached (R) / silent yet commanding (S)

A.  PQSR

B.  QSRP

C.  RSPQ

D.  SRQP

✓

Q52 English
Choose the correct indirect speech for the following:
Swathi said, “I can swim.”

A.  Swathi said that she can swim.

B.  Swathi told that she could swim.

C.  Swathi said that she could swim.

D.  Swathi said she can swam.
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✓

Q53 English
Select the most appropriate antonym of the underlined word in the given sentence.

Her analysis of the poem was superficial.

A.  profound

B.  shallow

C.  brief

D.  simple

✓

Q54 English
Complete the sentence by choosing the correct option.
Global warming is a ................. issue that requires immediate international cooperation.

A.  exclusive

B.  critical

C.  determined

D.  gracious

✓

Q55 English
In the following question choose the word opposite in the meaning to the underlined word.
The scholar was known for his profane language during the heated debate.

A.  pious

B.  temporal

C.  worldly

D.  irreverent

✓

Q56 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The rising and falling actively motion of the ocean made the boat sway gently.

A.  snoozing

B.  shrinking

C.  surging

D.  polishing

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q57 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. bloomed, painting the
B. a kaleidoscope
C. landscape with
D. the vibrant flowers
E. of colours

A.  BACDE

B.  CBADE

C.  DACBE

D.  BEACD

✓

Q58 English
Select the option that can be used as a one-word substitute for the underlined group of words.

All wars change society and hence leave an imprint on literary culture that cannot be erased or forgotten.

A.  indelible

B.  inedible

C.  impressive

D.  indecisive

✓

Q59 English
Select the option that expresses the given sentence in active voice.

The solution had been proposed by the scientist before the conference began.

A.  The scientist has proposed the solution before the conference began.

B.  The scientist proposed the solution before the conference had begun.

C.  The scientist had proposed the solution before the conference began.

D.  The scientist proposed the solution before the conference began.

✓

Q60 English
Complete the sentence with a contextually and grammatically appropriate adjective.

The ___ street was filled with laughter and music.
3635

A.  desolate

B.  remarkable

C.  instrumental

D.  bustling
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଢେଙ୍କାନାଳ ଓଡ଼ି ଶାର ଏକ ପ୍ର ସି ଦ୍ଧ ହସ୍ତତନ୍ତ କେନ୍ଦ୍ର ଅଟେ ।

A.  Dhenkanal is a famous handicraft center of Odisha.

B.  Dhenkanal is the capital city of Odisha.

C.  Dhenkanal is a hill station in North India.

D.  Dhenkanal is a temple in Andhra Pradesh.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଟି କଟଘରଟି  ରେଳ ଷ୍ଟେସନରେ ରହି ଅଛି  ।

A.  The ticket counter is at the railway station.

B.  Ticket counter are in railway station.

C.  Ticket counters is on the station railway.

D.  The ticket counter be in the railway stations.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୃ ତ୍ରି  ମ ବୁ ଦ୍ଧି ମତା ମନୁ ଷ୍ୟ ମସ୍ତି ଷ୍କର ଚି ନ୍ତନ ପ୍ର ଣାଳୀ ପରି  ଅନୁ କରଣ କରେ ।

A.  Artificial Intelligence imitates the thinking process of the human brain.

B.  Artificial Intelligence is a machine that replaces human brains.

C.  Artificial Intelligence can think without any data.

D.  Artificial Intelligence destroys human thoughts.

✓

Q64 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।

ଧର୍ମ ର ପରି ଭାଷା ଅବି ଚଳ, ଅଟଳ, ଶାଶ୍ଵତ । ଏହା ମନୁ ଷ୍ୟର ସମ୍ବେଦନାର ଜାଗରଣ। ଧର୍ମ ର ବ୍ୟାଖ୍ୟାକୁ  ଜଟି ଳ କରି ବା ପ୍ର କ୍ରି  ୟା ବି ଭି ନ୍ନ ସମୟରେ ତଥାକଥି ତ ଧର୍ମା ନ୍ଧମାନେ ହିଁ ଆରମ୍ଭ କରି ଥାନ୍ତି  ।
ଧର୍ମ ର ପରି ଭାଷା ସରଳ । ଜଣେ ଛୋଟ ପି ଲା କହି ପାରି ବ ଯେ ଅନ୍ୟକୁ  ପୀଡ଼ା ଦେବା ଅଧର୍ମ , ଅନ୍ୟର ପୀଡ଼ା ଉପଶମ ଧର୍ମ ର ପରି ଚାୟକ । ଦୁଃ ଖୀର ଦୁଃ ଖ ଅପନୋଦନ, ପଥଛାଡ଼ି  ଅପଥରେ ଘୂ ରି
ବୁ ଲୁ ଥି ବା ବ୍ୟକ୍ତି ଙ୍କୁ  ସତ୍ ‌ପଥକୁ  ଆଣି ବା ଧର୍ମ ର ସ୍ଵରୂ ପ ନୁ ହେଁ  ତ ଆଉ କ'ଣ? ପ୍ର ସି ଦ୍ଧ ଦାର୍ଶ ନି କ, ସନ୍ଥ, ଲେଖକ ଲି ଓ ଟଲଷ୍ଟୟଙ୍କ ସମ୍ପର୍କିତ ନି ମ୍ନୋ କ୍ତ ପ୍ରେ ରଣାଦାୟୀ, ଶି କ୍ଷାପ୍ର ଦ ପ୍ର ସଙ୍ଗ। ଟଲଷ୍ଟୟ ଖାଲି

ପ୍ର ସି ଦ୍ଧ ଲେଖକ ନଥି ଲେ । ତାଙ୍କଠାରେ ଅନ୍ୟ ଏକ ବି ଶେଷ ଗୁ ଣ ଥି ଲା ଯାହାକୁ  ହୁ ଏତ ଅନେକେ ଜାଣି  ନଥି ବେ। ଟଲଷ୍ଟୟ ଥି ଲେ ଜଣେ ସମ୍ବେଦନଶୀଳ ବ୍ୟକ୍ତି ତ୍ଵ । ଅନ୍ୟର ଦୁଃ ଖ ସହି  ପାରୁ ନଥି ଲେ।
ନି ଜର ସାଧ୍ୟମତେ ସାହାଯ୍ୟ କରୁ ଥି ଲେ ଦୁଃ ଖୀ, ନି ପୀଡ଼ି ତଙ୍କୁ  । ଏହି  କାରଣରୁ  ପ୍ର ତ୍ୟହ ତାଙ୍କ ଘର ସମ୍ମୁଖରେ ଭି କାରି ଙ୍କ ଲମ୍ବା ଧାଡ଼ି  ଲାଗୁ ଥି ଲା । କାହାକୁ  ବି  ନି ରାଶ କରୁ ନଥି ଲେ । କାହା କାହାରି କୁ  ଅର୍ଥ ,
ବସ୍ତ୍ର, ଏପରି କି  ପି ନ୍ଧି ଥ‌ି ବା କୋଟ୍  ମଧ୍ୟ ଦାନ ଦେଇ ଦେଉଥି ଲେ । ଖୁ ବ୍ ‌ଶୀଘ୍ର  ଏପରି  ସ୍ଥି ତି  ହେଲା ଯେତେବେଳେ କି  ତାଙ୍କ ପାଖରେ ଦାନ ଦେବାକୁ  କି ଛି  ନଥି ଲା । ସେଦି ନ ଯାଚକଙ୍କ ଧାଡ଼ି ରେ ସବା
ପଛରେ ଜଣେ ବ୍ୟକ୍ତି  ଠି ଆ ହୋଇଥାନ୍ତି  । ଦୁ ର୍ବ ଳ କାରଣରୁ  ବହୁ ତ ଆଗରୁ  ଆସି ଥି ଲେ ମଧ୍ୟ ସମ୍ମୁଖକୁ  ଆସି  ପାରି  ନଥି ଲେ- ଭି ଡ଼ କମି ବାରୁ  ସବା ପଛରେ ଟଲଷ୍ଟୟଙ୍କ ନି କଟକୁ  ଆସି ଥି ଲେ ।
ସେତେବେଳକୁ  ଟଲଷ୍ଟୟ ସବୁ  ଦାନ ଦେଇ ଖାଲି  ହୋଇ ଯାଇଥାନ୍ତି । ପଛରେ ଆସି ଥ‌ି ବା ବ୍ୟକ୍ତି ଙ୍କୁ  ଦେଖି  ଗଳାରେ ଲଗାଇ ଆଲି ଙ୍ଗନ କରି  କହି ଥି ଲେ- ଭାଇ! ଏବେ ତୁ ମକୁ  ଦେବାକୁ  ମୋ ନି କଟରେ କି ଛି
ବଞ୍ଚି  ନାହିଁ (ବଳକା ନାହିଁ) । କାଲି  ଆସି ଲେ ନି ଶ୍ଚୟ ତୁ ମ ପାଇଁ  କି ଛି  ରଖି ଥି ବି  । ତାଙ୍କଠାରୁ  ଏଭଳି  ଶୁ ଣି  ଯାଚକ କହି ଥି ଲେ- ‘ଆପଣ ଏଭଳି  କହନ୍ତୁ ନାହିଁ ମହାତ୍ମା । ଆପଣ ଆଜି  ଆଜି  ଯାହା ମୋତେ

ଦେଇଛନ୍ତି , ପୂ ର୍ବ ରୁ  ମୋତେ କେହି ବି  କେବେ ତାହା ଦେଇ ନଥି ଲେ । ଧନ ଦାନକାରୀ ତ ଅନେକ ମି ଳି ବେ, ମି ଳି ବେ, ହେଲେ ହେ ଏଭଳି  ପ୍ରେ ମ, ଆଦର ଦାନକାରୀ ଜଣେ ବି  ମି ଳି ବେ ନାହିଁ । ଅନନ୍ୟ
ପ୍ରେ ମ- ସମ୍ବେଦନ କେବଳ ଆପଣ ହିଁ ଦେଇଛନ୍ତି  ଯାହା ମୋ ଭଳି  ନିଃ ସ୍ଵ ପାଇଁ  ମହାର୍ଘ  ସମ୍ପଦ।'

ଅନୁ ଚ୍ଛେଦଟି ର ସ୍ଵର ଚି ହ୍ନଟ କର ?

A.  ହାସ୍ୟମୟ

B.  ପ୍ରେ ରଣାଦାୟୀ ଓ ଶି କ୍ଷାପ୍ର ଦ

C.  ଆଲୋଚନାମୂ ଳକ

D.  ବ୍ୟଙ୍ଗାତ୍ମକ
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✓

Q65 Odia
‘ଜଟି ଳ’ ଶବ୍ଦର ବି ପରୀତ ଶବ୍ଦଟି  କ'ଣ?

A.  କଠି ନ

B.  ସରଳ

C.  ଗୁ ରୁ ତର

D.  ଅସ୍ପଷ୍ଟ

✓

Q66 Odia
‘ସମ୍ବେଦନଶୀଳ’ ଶବ୍ଦଟି  କେଉଁ  ବ୍ୟକ୍ତି ଙ୍କୁ  ବୁ ଝାଏ?

A.  ଯେଉଁ  ବ୍ୟକ୍ତି  ଅନ୍ୟଙ୍କୁ  କଷ୍ଟ ଦେଇଥାଏ

B.  ଯେଉଁ  ବ୍ୟକ୍ତି  ଅନ୍ୟର ଦୁଃ ଖ ବୁ ଝି  ସହାନୁ ଭୂ ତି  ଦେଖାଏ

C.  ଯେଉଁ  ବ୍ୟକ୍ତି  ସବୁ କି ଛି କୁ  ଅବହେଳା କରେ

D.  ଯେଉଁ  ବ୍ୟକ୍ତି  ସଦା କ୍ରୋ ଧି ତ ରହେ

✓

Q67 Odia
ଅନୁ ଚ୍ଛେଦର ମୁ ଖ୍ୟ ବି ଷୟବସ୍ତୁକୁ  ଚି ହ୍ନଟ କର ।

A.  ଧର୍ମ ର ଜଟି ଳତା

B.  ଦାନର ପ୍ର କାର

C.  ସମ୍ବେଦନଶୀଳ ବ୍ୟକ୍ତି ତ୍ଵ

D.  ଯାଚକମାନଙ୍କ ଜୀବନ

✓

Q68 Odia
ଏହି  ଅନୁ ଛେଦର ଗଢଣ ଚି ହ୍ନଟ କର ?

A.  ବର୍ଣ୍ଣ ନାତ୍ମକ

B.  କାହାଣୀମୂ ଳକ

C.  ପରୀକ୍ଷାମୂ ଳକ

D.  ବି ଶ୍ଳେଷଣାତ୍ମକ

✓

Q69 Odia
"ଖୋଳ ପର୍ବ ତ ମାର ମୂ ଷା"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ବଡ କାମ ପାଇଁ  ଅଳ୍ପ ପରି ଶ୍ର ମ କରି ବା ।

B.  ସାମାନ୍ୟ କାର୍ଯ୍ୟ  ପାଇଁ  କଠି ନ ପରି ଶ୍ର ମ କରି ବା ।

C.  କଷ୍ଟ କରି ଲେ ବଡ ଫଳ ମି ଳେ ।

D.  କାମ ନକରି  ବସି  ରହି ବା ।

✓

Q70 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ଯବ

B.  ଜନ୍ଦା

C.  ଯଅ

D.  ଜନ୍ତାଳ
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✓

Q71 Odia
ବର୍ଷା ରେ ପାଣି  ଟୋପାଟୋପା ପଡୁ ଛି ।ଏହି  ବାକ୍ୟରେ ଥି ବା କ୍ରି  ୟାବି ଶେଷଣ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ବର୍ଷା ରେ

B.  ଟୋପାଟୋପା

C.  ପାଣି

D.  ପଡୁ ଛି

✓

Q72 Odia
'ସମ୍ଭାବନାସୂ ଚକ ଅବ୍ୟୟ' କାହାକୁ  କୁ ହାଯାଏ ?

A.  ଯେଉଁ  ଅବ୍ୟୟ କାଳକୁ  ବୁ ଝାଏ ।

B.  ଯେଉଁ  ଅବ୍ୟୟ ସମ୍ଭାବନା ପ୍ର କାଶ କରେ ।

C.  ଯେଉଁ  ଅବ୍ୟୟ ସ୍ଥାନକୁ  ବୁ ଝାଏ ।

D.  ଯେଉଁ  ଅବ୍ୟୟ ସମ୍ବୋଧନକୁ  କରେ ।

✓

Q73 Odia
‘ପୋଥି  ବାଇଗଣ' - ରୂ ଢ଼ି ର ଅର୍ଥ  ଲେଖ ।

A.  ପୁ ସ୍ତକ ବହି ର୍ଭୂ ତ ବି ଦ୍ୟା

B.  ପୁ ସ୍ତକଗତ ବି ଦ୍ୟା

C.  ପୋଥି ଗତ ଚି ତ୍ର

D.  ପୋଥି  ପାରି ବା

✓

Q74 Odia
ଶର୍ମିଷ୍ଠା ଭଲ କହି ପାରେ, --------- ଗାଇପାରେ ନାହିଁ । - ଉପଯୁ କ୍ତ ଅବ୍ୟୟ ପଦଟି  ବାଛି  ଶୂ ନ୍ୟ ସ୍ଥାନ ପୂ ରଣ କର ।

A.  ତେଣୁ

B.  ଯେଉଁ ଥି ପାଇଁ

C.  ମାତ୍ର

D.  ଯଦି

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  କଫି

B.  ଗି ରଫ

C.  ବାମ୍ଫ

D.  ଚଷମା
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Computer

✓

Q76 Computer
Which option in MS PowerPoint 2021 displays the presentation in
full screen with animation and transitions?

A.  Slide Show View

B.  Design View

C.  View Pane

D.  Slide Sorter

✓

Q77 Computer
A student is creating a presentation in PowerPoint 2021 and
comparing starting with a blank file versus a template. Which
statement is True or False?
(i) A Blank Presentation starts with a 'Title Slide' layout, and no other
slide type can be inserted until the user changes the master slide
settings.
(ii) A Template with a theme can be changed anytime via the Design
tab, and custom effects (shapes, text boxes) added by the student
remain unchanged.

A.  (i) True, (ii) True

B.  (i) True, (ii) False

C.  (i) False, (ii) True

D.  (i) False, (ii) False

✓

Q78 Computer
What is the shortcut key to insert a new row above the selected row?

A.  Ctrl + R

B.  Shift + Delete

C.  Ctrl + Shift + “+”

D.  Alt + Insert

✓

Q79 Computer
When you save your presentation in PowerPoint for the first time,
which command is appropriate?

A.  File → Save As → choose format and location

B.  File → Close → Save

C.  Home → Save

D.  View → Save As Template

✓

Q80 Computer
Which function in MS Word 2020 lets you select text for editing, such
as changing its font or color?

A.  Highlighting

B.  Saving

C.  Printing

D.  Closing

✓

Q81 Computer
What happens to attachments when you use the “Reply” or “Reply
All” options?

A.  Attachments are automatically included

B.  Attachments are replaced with updated versions

C.  Attachments are not included

D.  Only images are included

✓

Q82 Computer
Which component is primarily responsible for executing instructions
and performing calculations?

A.  CPU

B.  Hard Disk

C.  Monitor

D.  Mouse

✓

Q83 Computer
What does the Task Manager do in the computer?

A.  It does the software implementation of the device.

B.  It does the printing of the data in the device.

C.  It does the hardware implementation of the device.

D.  It optimizes the performance.

✓

Q84 Computer
Select the correct values for the alignment of text within the
paragraph in MS Word.
i. Left
ii. Right
iii. Justified
iv. Top
v. Bottom

A.  i, ii, iii, iv, and v

B.  i, ii, and iii only

C.  i, iii, iv, and v only

D.  ii, iii, iv and v only
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✓

Q85 Computer
Which of the following MS Excel functions is used to perform a
vertical lookup in a table?

A.  HLOOKUP

B.  VLOOKUP

C.  INDEX

D.  MATCH

✓

Q86 Computer
A company needs to store large software installation files on a
portable Medium for distribution. Which of the following is most
likely to be used?

A.  CD

B.  LAN

C.  ASCII

D.  RAM

✓

Q87 Computer
The latest desktop processors are part of the ______ generation
(Raptor Lake).

A.  14th

B.  15th

C.  16th

D.  12th

✓

Q88 Computer
In MS Word 2010, what happens when you click ‘Save As’?

A.  Closes the file

B.  Deletes the file

C.  Saves a copy under a new name or location

D.  Saves and prints the file

✓

Q89 Computer
What essential character separates the username from the domain
in an email address?

A.  # sign

B.  $ sign

C.  & sign

D.  @ sign

✓

Q90 Computer
Which action would most likely be necessary before performing any
calculations in a new spreadsheet document?

A.  Closing all previous documents

B.  Opening a new workbook

C.  Logging out of the system

D.  Running antivirus software
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Reasoning

✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the wife of B’,
'A – B' means ‘A is the brother of B’,
'A x B' means ‘A is the mother of B’,
'A = B' means ‘A is the father of B’.

How is P related to Q if ‘P + R – Y = S x Q’?1951

A.  Mother's father's brother's wife

B.  Mother's mother

C.  Sister

D.  Wife

✓

Q92 Reasoning
Seven people—H, I, J, K, L, M and N—are sitting in a straight line,
facing the north. H sits fourth from the extreme right end of the line.
Only two people sit between H and K. I sits third to the right of H. M
sits fourth from the right of K. Only L sits between K and N. Who is
sitting at the second position from the extreme right end of the line?

A.  L

B.  M

C.  J

D.  N

✓

Q93 Reasoning
G, H, I, J, K and L live on six different floors of the same building. The
lowermost floor in the building is numbered 1, the floor above it,
number 2 and so on till the topmost floor is numbered 6.
The product of floors on which G and J live is 15. L lives immediately
above K. The sum of floors on which H and J live is 7. How many
people live below K?

A.  0

B.  2

C.  3

D.  4

✓

Q94 Reasoning
If + means −, − means ×, × means ÷ and ÷ means +, then what will
come in place of the question mark (?) in the following equation?

14 − 4 ÷ 55 + 99 × 11 = ?

A.  102

B.  113

C.  149

D.  176

✓

Q95 Reasoning
In a certain code language, ‘HATS’ is coded as ‘4361’ and ‘THIS’ is
coded as ‘6139’. What is the code for ‘I’ in the given code language?

A.  6

B.  1

C.  3

D.  9

✓

Q96 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
ONM : QPJ
KJG : MLD

A.  TML : VOH

B.  PRE : RSB

C.  QEJ : SGF

D.  JQX : LSU

✓

Q97 Reasoning
Which of the following options will replace the question mark (?) in
the given series to make it logically complete?

ZWZY WTWV ? QNQP NKNM

A.  NOQP

B.  TQTS

C.  NLML

D.  NJML

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.
Statements: Some Jaz are Blues. All Blues are Rocks.
Conclusion I: All Jaz are Rocks.
Conclusion II: Some Rocks are Jaz.14522

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow
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✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter cluster)5677

A.  MO-PS

B.  LN-OQ

C.  AC-DF

D.  JL-MO

✓

Q100 Reasoning
Refer to the following letter series and answer the question.
(Left) P L O K I J U H Y G T F R D E S W A Q (Right)
How many letters are there in the English alphabetical order
between the letter which is third from the left end and the letter
which is fourth from the right end of the series? 5524

A.  Three

B.  Five

C.  Four

D.  Six
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